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You may not reproduce, transmit, transcribe, store in a retrieval 
system or translate into any human or computer language this 
manual and software. These actions, in any form or by any 
means, are illegal without the express written permission of Pur i-
tas Spr ings Software. 
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During the period of time before a major upgrade, if the disks that make up the then-current 
version of this software are defective, then return the software to Pur itas Spr ings Software, 
645 McKee Trail, Hinckley, Ohio 44233-9209 and replacement disks will be mailed to you. 
Pur itas Spr ings reserves the right to define and decide what constitutes a major upgrade. 
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Puritas Spr ings Software provides Franklin County Probate Forms (Frank10) for Win-
dows, consisting of both the software and this manual, "AS IS." The software and manual 
carry no warranty as to performance, merchantability or fitness for any particular use. Pur i-
tas Spr ings Software specifically disclaims all warranties, express or implied, regarding the 
software or our services, and Pur itas Spr ings Software does not warrant that the software 
or services are free from defects, interruption, errors or other program limitations. For states 
containing limitations on implied warranties, any such implied warranties are limited to 60 
days from the date of purchase. The rights provided by this Limited Warranty shall be lim-
ited to the original, registered and recorded purchaser of the software. Said rights are limited 
to the cost of the software and are non-transferable. You assume all liability and responsibil-
ity for the accuracy of any form produced by this software. Recognizing this, Pur itas 
Spr ings Software has exercised due care in the preparation of the software and manual. In 
no event, however, shall the authors or publisher be liable for direct, incidental or conse-
quential damages, or damages of any type, arising from the use of Frank10 for Windows. 
 
This Agreement sets forth Pur itas Spr ings Software’s entire liability and your exclusive 
rights and remedy with respect to the software. Headings are included for convenience and 
shall not be considered in interpreting this Agreement. This Agreement does not limit any 
rights that Pur itas Spr ings Software may have under trade secret, copyright, patent or 
other laws, federal or state. 
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Franklin County Probate Forms (Frank10) is 
a 32-bit Windows application that runs in Win-
dows 7, Vista, XP, 2000, ME, and Windows 
98. 
 
System Requirements. Frank10 requires a 
Pentium or equivalent processor with at least 
64 MB of RAM. Frank10 comes on a compact 
disk (CD) and requires between 4 and 12 
megabytes of hard disk space. Frank10 re-
quires an SVGA video card capable of display-
ing a minimum of 256 colors at a minimum 800 x 600 resolution. Frank10 works 
with any Windows-compatible printer. A larger resolution works better for viewing 
the various worksheet screens. 
 
COPYRIGHT NOTICE. United States copyright laws protect Frank10 as the 
property of Pur itas Spr ings Software. Your Frank10 distribution disk contains a 
registered serial number that is hidden in various places inside the software. Posses-
sors of unauthorized copies violate Federal law. 
 
In General. The Frank10 distribution CD contains many files, some of which are 
shown below. You don©t need to know anything specific about them. The instal-
lation program automatically transfers them to your hard drive and Frank10 uses 
them during program operation. The list below is for reference only. 
 
These files are essential to the proper operation of Frank10 . If any of these files 
becomes corrupted or relocated, you must reinstall Frank10 from the CD. In most 
instances this will involve removing the program pr ior  to re-installation. To 
learn more about re-installing, see the applicable section on pages 6 and 7 of this 
manual. The removal/re-installation process will not affect your client F10 data 
files. Naturally, you should back up the data directory (� ��� � ) periodically to protect 
your client data. 

 
 

FRANK10.EXE is the executable file that represents the Frank10 program; 
 
FRANK10.HLP is a file that is used by Frank10’s on-line help system. It 

must always be in the same directory as the executable file; 
 
DEFAULT.F10 is a necessary file that seeds any new client file you create. 

It must be located in the � � � �client file directory, usually 
	 
�� 
 ���� � �� �� � � � � �� ��� � . It should be modified by the user so it 
contains the personalized startup values for Frank10, i.e., 
attorney’s name, address, telephone number and Supreme 
Court registration number. 
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PAGEXX.DAT are a series of files numbered 1 through X that are used 

internally by Frank10 to define the characteristics of the 
data that is printed on the forms. 

 
PAGEXX.RTF are a series of files numbered 1 through X that are used 

internally by Frank10 to generate the forms that are dis-
played on your screen and sent to your word processor. 

 
RTFIndex.TXT is a text file that contains a list of all the form templates in 

Frank10. It is used by Frank10 as an index for modifying 
the form templates. It must be in the same directory as the 
Frank10 executable. If this file is not present or is not in the 
correct location, the � � � ��� �� � � � �� �� � �command on the � � �
��� � � �menu will not work. 
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Overview 
 

Install Franklin County Probate Forms—
Version 10 (Frank10) to your computer by 
following the instructions below. 
 

Network Installations�
 
In the case of non-network installations, we recommend installing Frank10 in the 
default directory (C:\Program Files\Puritas\Frank10\). In the case of network in-
stallations, the types and implementations are diverse and we cannot give network-
specific technical support although we answer questions about Frank10 to assist 
network administrators during installation and setup. You will not be able to install 
or configure Frank10 for networks unless you purchased a multi-user or network 
license. 
 

Installation Steps�
 

In General 
 

Before starting the installation, we should mention that the files on the distribution 
CD are compressed, and therefore, you must “ install”  Frank10 to your computer 
rather than simply copying the files from the CD to your hard drive. For that same 
reason, you cannot run Frank10 from the CD. You must install Frank10 to your 
hard drive. 
 

Installation Steps 
 

A. Place the distribution disk in your drive. 
 
B. The following three steps start the installation process: 
 

1. Press the Start button; 
 
2. Click on the Run item; and 
 
3. Type the command shown below. Note that not all DVD/CD players 

are designated as dr ive D, so if you’ re installing from a different 
dr ive, you must use the correct dr ive letter . Always use the DVD/CD 
drive with the lowest drive letter. 

 
D:SETUP.EXE 

 

Installation 
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C. The Setup progress meter will appear until the Welcome dialog appears. Click 
the Next button to proceed with installation. Click Cancel if you want to abort 
installation. 

 
D. The Pur itas Spr ings Software L icensing Agreement appears in the next dialog. 

Press the Yes button to accept the terms and conditions of the license and con-
tinue with the installation. If you do not agree to the terms of the Licensing 
Agreement, you will not be able to continue installing the program. 

 
E.   Verify your user identification information and click the Next button. 
 
F.   Verify the installation directory. We strongly recommend C:\Program 

Files\Puritas\Frank10\ which is the default. If you want to use an alternate 
installation directory or drive, you can use the Browse button to make your selec-
tion. Click the Next button to continue. 

 
G. The next dialog, the Select Program Folder dialog, lets you select the program 

folder. The default answer is “Puritas Springs Software” . Click on the Next but-
ton to continue. 

 
H. Verify the database or client file directory. We strongly recommend 

C:\Puritas\Frank10\Files which is the default. If you want to use an alternate 
installation directory or drive, you can use the Browse button to make your selec-
tion. Click the Next button to continue. 

 
I. The installation begins when you click the Next button in the Start Copying Files 

dialog. A progress meter will keep you informed as the program files are trans-
ferred from the DVD/CD to your hard drive. 

 
J. When the entire installation process is complete, the Setup Complete dialog ad-

vises you that the installation process was successfully completed. It is advisable 
to leave the Reboot option checked and click the Finish button. Your computer 
will reboot and you’ re ready to run Frank10. 

 

Running Frank10 
 
You start Frank10 by clicking on the Frank10 icon that is on your desktop or by 
clicking the Start button, selecting the Programs submenu, then the Puritas 
Springs Software submenu and finally selecting the Frank10 item. You can also 
double-click on any F10 file and Frank10 will start and automatically open the F10 
file. 
 

Updating and Reinstallation 
 
If you wish to download a free upgrade from our web site (www.puritas-
springs.com), please read this section. 
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1. Download the Upgrade. 

A. Click on Frank10’s Help menu and select Download Upgrade. 

B. In the Download Upgrade dialog box, click on the Check Availability but-
ton. Note that some systems, typically networks, may have security software 
and/or hardware in place that prohibit downloading executable files. If this is 
true in your office or you are having problems with the download, check 
with your network administrator. 

C. After clicking the Check Availability button, you may get one of three re-
sponses. 

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on 
Download Upgrade button and see the file downloading. 

2) You are notified that there is no newer version available, in which case, 
you’ re done. 

3) A message indicates an error, i.e., “HTTP Get Failed.”  Talk with your 
network administrator or send in your disk according to our instructions 
on the Current Versions page of our web site: www.puritas-
springs.com. 

2. Remove Frank10. First, it is important to know that removing the Frank10 
program using Windows’  Add/Remove function will not delete or  harm 
your  client files. That being said, you should always back up the Files subfolder 
that is contained within the Frank10 program folder. It is there that your client 
files are stored. The default path is C:\Puritas\Frank10\Files\. Here are the 
steps for removing the prior version of Frank10. The exact procedure will differ 
from one version of Windows to the next, but the basics are the same. 

A. Exit the Frank10 program. 

B. Click on the Start button. From the Start menu select Settings, and then 
Control Panel. Note that in some Windows versions, you may need to navi-
gate to Control Panel in a different way. However, once in Control Panel, 
double-click the Add/Remove Programs icon. If you don’ t see the Add/
Remove Programs icon, you may need to click on the Classic View link 
or option. Note that in later versions of Windows the “ removal”  process is 
referred to as “uninstalling.”  

C. Select Frank10 from the program list within the Install/Uninstall tab. With 
the Frank10 item highlighted, click the Add/Remove button. 

D. When the Welcome dialog appears, click the Next button to begin the re-
moval process. 

E. The next dialog box to appear is titled Program Maintenance. Click the 
radio button next the Remove item, and then click the Next button. 

F. Remove the Program is the next dialog box to appear. The InstallShield 
Wizard will begin to remove the old Frank10 program when you click the 
Remove button. 



0000





&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 
&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 
&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 
&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 






G. You are notified when the removal function is complete. In the dialog box 
that appears, click the Finish button to close the InstallShield Wizard 

3. Install the New Version. The final step in the upgrade process is to install the 
new version by executing the file you downloaded. The name of the downloaded 
file is setupfrank10.exe (note that sometimes the exe extension is hidden) and 
it is located by default at C:\Puritas\Frank10\Files. When you find the file, 
double-click on it and follow the installation instructions contained on page 5 of 
this manual. If you don’ t know how to find the file, try following these steps: 

A. Go to My Computer 

B. Double-click the C:/ or Local Hard Drive icon. 

C. Double-click the Puritas folder. 

D. Double-click the Frank10 folder 

E. Double-click on the Files folder 

You should see the setupfrank10.exe file. Double-click on it to begin the installa-
tion. 
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Franklin County Probate Forms for Windows
-Version 10 (Frank10) starts by displaying the 
Main Window. After you get to know 
Frank10, you’ ll discover that you can display 
and complete any form or worksheet in any 
order. For now, however, it is best to follow the 
logic and organization of the Main Window.  
 
Before getting into the actual steps involved in completing a set of probate forms, it’ ll 
will help to understand a bit more about the Main Window and how it can help make 
completing forms and understanding program operation a lot easier. 
 
The Main Window 

The Main Window 
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Overview 
 
Tree View. The pane on the left side of the Main Window contains a tree view of 
all the forms and functions in Frank10. You should be familiar with the look and 
feel of the tree view because it is a standard Windows component. You may recog-
nize it as part of the Windows Explorer user interface. You can do two things in the 
tree view – click on nodes or click on items. Also, if you ever cover the Main Win-
dow with a form and wish to see it again, you can click on the Main Window button 
on the button bar or use the Display menu©s Main Window command. The vertical 
divider that separates the left window from the right can be dragged horizontally to 
adjust the relative sizes of these windows to your liking. 
 
Nodes. Nodes are the [+] or [-] buttons you see in front of certain items in the tree 
view. The [+] sign means that there are elements or subitems hidden within that 
item. You can view or expand the subitems by clicking on the [+]. When you do, 
you©ll see the list of subitems and the [+] will change to a [-]. If you wish to collapse 
or hide the subitems, click on the [-]. Note that when you expand an item, its 
subitems may also have subitems. Even those subitems can have subitems. There©s 
no limit to subitems in the tree view. You can see all of the items at the same time 
by right-clicking your mouse in the tree view and selected Expand Tree View from 
the pop-up menu. 
 
I tems. Clicking on the items will display either (1) a relevant instruction page in the 
right-side window pane, or (2) a particular form that you wish to view or complete. 
 
Star t Here. As mentioned earlier, even though you can click on any item in any or-
der, we©ve arranged the first level of subitems in a top-to-bottom order that logically 
organizes the data entry process. Click on the [+] to the left of the Start Here item 
to begin. You©ll see the first level of subitems: 
 

1. General Information 
This single form contains a lot of background information. The sort of infor-
mation you©d like to print and staple to the inside cover of your client file. 
Basic case information, decedent and surviving spouse information, attorney 
information, phone numbers, dates, etc. The information you enter on the 
General Information form is used again and again as Frank10 automati-
cally completes the various required probate forms. 
 
2. Name &  Save File 
The rule about saving your file is — early and often. Having just completed 
the General Information Worksheet, now is a good time to name your file 
and save your work. Frank10 will save your client file in the location set for 
F10 files on the Options menu. This location is set during installation and 
by default is: C:\Puritas\Frank10\Files. 
 
3. Children, Next of Kin, Legatees, Devisees  
This item displays an explanation of the Children, Next of Kin, Legatees 
Worksheet in the right pane of the Main Window. As you can guess from 
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the name, it is the central location for entering information about the dece-
dent©s children, next of kin, legatees and devisees. By entering this informa-
tion into the worksheet, all relevant information is in one place. From this 
worksheet, by simply clicking your mouse, this information can be directed 
to nearly 40 probate forms like Consents, Waivers and Notices. To display 
the Children, Next of Kin, Legatees Worksheet, click on the node [+] to 
the left of this item and then click on the Worksheet subitem. 
 
4. Income/Assets/Receipts 
This item displays an explanation of the Income/Assets/Receipts Work-
sheet in the right pane of the Main Window. This worksheet provides a cen-
tral location for entering information about estate income, assets and re-
ceipts. By entering this information into the worksheet, all relevant financial 
information is in one place. From this worksheet, by simply clicking your 
mouse, this information can be directed to over 100 pages of forms that re-
quire such information including any schedule of the Ohio Estate Tax return. 
Note that our Ohio Estate Tax is a separate program. To display the In-
come/Assets/Receipts Worksheet, click on the node [+] to the left of this 
item and then click on the Worksheet subitem. 
 
5. Expenses/Debts/Disbursements 
This item displays an explanation of the Expenses/Debts/Disbursements 
Worksheet in the right pane of the Main Window. This worksheet provides 
a central location for entering information about estate expenses, debts and 
disbursements. By entering this information into the worksheet, all relevant 
financial information is in one place. From this worksheet, by simply click-
ing your mouse, this information can be directed to the few forms that re-
quire such information including appropriate schedules of the Ohio Estate 
Tax return. To display the Expenses/Debts/Disbursements Worksheet, 
click on the node [+] to the left of this item and then click on the Worksheet 
subitem. 
 
6. Time and Services 
This item displays an explanation of the Time and Services Worksheet in 
the right pane of the Main Window. This worksheet provides a central loca-
tion for entering information about attorney time and services rendered with 
respect to the administration of the decedent©s estate. By entering this infor-
mation into the worksheet, all relevant information is in one place. This in-
formation is used by Frank10 to complete the Application for Attorney 
Fees together with an itemized exhibit of time and services. To display the 
Time and Services Worksheet, click on the node [+] to the left of this 
item and then click on the Worksheet subitem. 
 
7. Displaying Forms 
This item contains an expandable hierarchy that contains a link to all the 
forms, schedules, letters and other documents contained in Frank10. It paral-
lels the Display menu. Note that if you’ re jumping to page 2 of a two-page 
form, it’s often quicker to use the Display menu versus the Main Window 
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and then the Paging button on the tool bar. The Page Selector button(s) are 
on the tool bar at the top of the page and contain a red arrow icon. 
 
8. Save File 
This it the often part of the saving rule. You’ve done more work in the file 
and this a reminder to save your changes. You won’ t see much happen be-
cause the save happens very quickly. The file already has a name (from Step 
2), so the Save As dialog will not appear. 
 
9. Pr inting Forms 
Clicking on this item takes you to the Print Selected Forms dialog from 
which you can print any single form or batch of forms. There are no subitems 
with respect to this item. 
 
10. Sending Forms to Your  Word Processor  
Clicking on this item takes you to the Send Selected Forms dialog from 
which you can send any single form or batch of forms to your word proces-
sor. There are no subitems with respect to this item. Frank10 works best 
with Microsoft©s Word for Windows, but can be used with most word proces-
sors capable of handling rich text format (RTF) files. When it ships, 
Frank10 is set to use Word for Windows. If you use a different word proc-
esser, you can go to the Options menu©s Set Word Processor function to 
make the necessary adjustment. 
 

Getting Star ted. Assuming you©ve already clicked on the node [+] to the left of the 
Start Here item, you©re ready to start on a file now. Click on the General Informa-
tion item to display the General Information Worksheet. 
 
Finally 
 

Upgrades. As you are probably already aware, the probate forms don©t 
change too frequently when compared to forms like income tax returns. 
Some Standard Probate Forms, for example, date back to 1977. Conse-
quently, the need to perform upgrades is typically not too urgent. However, 
we do add features and make fixes periodically as matters are reported to us 
and therefore, you are encouraged to periodically use the Download Up-
grade feature on the Help menu to obtain any up-to-date program changes. 
 
Dates. Almost everywhere that a date is involved, WBOPF(Frank10) pro-
vides a convenient pull-down, date picker. If you prefer, you can still enter a 
date by hand, but make certain to use 4 digit years, i.e., "1985" instead of 
"85." Also note that you can change the year by clicking on the year at the 
top of the date-picker drop-down. The same is true of changing the month. 
 
Pr int This Page. This, and any other instruction page, can be printed by 
clicking on the Print button on the upper tool bar. 
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Beginning the Data Entry Process 
 
As explained above, entering probate information involves the following steps: 
 

1 Display and complete the General Information Worksheet; 

2 Enter next of kin, beneficiary, and interested party information on 
the Next of Kin Worksheet; 

3 Enter asset, income, and receipt information in the Asset/Receipt 
Worksheet; 

4 Make expense, debt, and disbursement entries in the Expense/
Disbursement Worksheet;  

5 Complete the remaining fields on any miscellaneous forms, i.e., 
Form 1.0 Surviving Spouse, Next of Kin, Form 2.0 Application to 
Probate Will, etc.; and 

6 Print the desired forms from the File|Print|Selected Forms dia-
log. 

7 Along the way, you can keep track of time you spend on the file by 
using our Time & Services Worksheet. This worksheet can be 
used as an exhibit to the Application for Allowance of Attorney 
Fees that is contained in Frank10, or it can be used separately and 
attached to any local forms that your jurisdiction uses. 

 
Frank10 does all calculations and transfers data from the worksheets automatically 
and instantaneously. You can find a tutorial file on your hard drive as one of the in-
stalled client files named SAMPLE.F10. Each step is discussed in a separate topic 
below. 
 

Step 1. Completing the General Info Worksheet 
 
You won’ t look hard to find the General Information Worksheet; it’s at the top of 
the Main Window’s tree view. You can also find it on the Display menu©s Work-
sheets submenu. When the General Information Worksheet first appears, the cur-
sor is blinking in the Name of Estate field. 
 
·  With the Name of Estate field active, type "ROBERT T. GRENESSEM". For 

this field we like to use all capital letters because this is the field that shows up in 
the caption area of all the probate forms. When you are through, press the <TAB> 
key. 

 
·  Complete the remaining fields as shown below. Press <TAB> after  each entry. 

When finished, your screen should look like the one shown on the next page. We 
can©t overemphasize the importance of pressing <TAB> after each entry. 
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 Field Answer 
 ------------------------------------------------------------------------------- 
 Name of Estate Robert T. Sample 
 Probate Judge Thomas E. Justice 
 County Franklin 
 Case Number 01-218743 
 Decedent©s Last Name Sample 
 First Name Robert 
 Initial T 
 Street Address 1234 Main Street 
 Post Office (Leave blank) 
 City Columbus 
 County Franklin 
 State Ohio 
 Zip Code 43215 
 Date of Birth 10/10/58 
 Soc Sec No 123-45-6789 
 Date of Death July 4, 2002 
 Cause of Death Carcinoma 
 Occupation Hospital Administrator 
 Retired No 
 Sex Male 
 Attorney©s Name Ward F. Stone 
 Address 17140 Lorimar Avenue 
 City Columbus 
 State Ohio 
 Zip Code 43215 
 Phone 614-251-8085 
 Supreme Court Reg No 00000001 

Completed General Information Worksheet 
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 Applicant/Fiduciary Name Joann Sample 
 Street Address 1234 Main Street 
 City Columbus 
 State Ohio 
 Zip Code 43215 
 Phone 614-447-1234 
 Title Co-Executrix 
 Co-Applicant/Fiduciary Name (leave blank) 
 Street Address (leave blank) 
 City (leave blank) 
 State (leave blank) 
 Zip Code (leave blank) 
 Phone (leave blank) 
 Title (leave blank) 
 Surviving Spouse Is Same As ... Checked* 
 *The remaining fields will automatically complete when the checkbox is checked. 
 
 Surviving Spouse Name Joann Sample 
 Street Address 1234 Main Street 
 City Columbus 
 State Ohio 
 Zip Code 43215 
 Phone 614-447-1234 
 Birthdate 9/19/64 
 Social Security Number 987-65-4321 
 
As you complete the General Information Worksheet there are a couple of points 
to note: 
 
1. Aside from clicking the mouse in any particular field, you can use the <TAB> 

key to move forward from field to field and <SHIFT><TAB> to move back-
wards through the fields. Get in the habit of using the <TAB> key. You must 
press the <TAB> key after making each entry. 

2. Checkboxes can be checked and unchecked by using your mouse or by using the 
spacebar on your keyboard. 

3. When you check the Surviving Spouse Is Same As Fiduciary checkbox, the 
remaining surviving spouse fields will complete automatically. 

 
IMPORTANT NOTE. Now that you have worked in the file for a few minutes, 
you will want to be sure to save your  client file by giving it a meaningful name. 
Select Save As from the File menu. When prompted for a name, use the client©s last 
name, i.e., “Smith, Joseph”  or “Miller, Thomas”, etc. Always use the ".F10" exten-
sion; better yet, leave it off completely and Frank10 will put it on for you. The rule 
about saving files is: If you haven©t named the file, use the Save As command to 
give it a name. If you already named the file (i.e., Sample, Robert.F10), use the 
Save command or the Save button. 
 

Step 2. Naming &  Saving Your File����
 
Now that you have worked in the file for a few minutes and completed the General 
Information Worksheet, you will want to be sure to save your  probate file by 
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giving it a meaningful name. Select Save As from the File menu. The standard 
Windows Save As dialog will appear. In the file name input box, use the client©s last 
name, i.e., “Smith, Joseph.” . It’s usually best to always use the ".F10" extension. By 
default, files are saved at C:\Puritas\Frank10\Files. 
 

Step 3. Completing the Next of K in Worksheet 
 
You may not know it from the short name, but this worksheet is for next of kin, 
beneficiaries, legatees, devisees, and any other interested parties. You can and 
should include names and addresses that will be used in conjunction with the enclo-
sure letters, i.e., the probate court filing desk, appraiser, insurance companies, etc. 
With a name like the one above, it’s easy to see why we simply refer to it as the Kin 
Worksheet. When we discuss the database worksheets (Kin, Asset, Expense & 
Time) in these help topics, we often use the term record to refer to a row in the ta-
ble, and the word field to refer to a column in the table. 
 
The following is some general information about the Kin Worksheet followed by 
specific information related to the Sample.F10 file. 
 
The Top Half &  The Bottom Half. The first thing you’ ll notice when you see the 
worksheet is that the screen is divided into two halves. The top half is where you do 
all your data entry; the bottom half is used to view and navigate through all your re-
cords. Although you can enter information in any order on the top part of the screen, 
we recommend working from left to right. Follow the tabbing order. When you first 
view the worksheet, it©s empty except for one blank record – that is, there’s one 
blank row in the bottom half and the empty contents of that row are displayed on the 
top half. If you work from left to right on this first record, you©ll proceed through the 
various fields described below. Note that when you click on any input control on the 
top part of the screen you’ ll see a helpful hint regarding that component on the status 
line at the bottom of the screen. Sometimes it’s a complete form name where the 
control, for space limitations, only shows the form number. The fields are self-
explanatory. 
 

·  Name. 
 

·  Address. This would be the street address, i.e., 1234 Main Street. 
 

·  City, State &  ZIP. 
 

·  Relationship. For example, “Son,”  “Daughter.”  Best to capitalize these. 
 

·  Bir th Date. Pick a date from the drop-down calendar. Note that the Month 
and Year labels of the calendar have drop-down lists that allow you to pick a 
month or year without needing to repeatedly page month by month. You can 
also type in the field and enter dates manually using the MM/DD/YYYY for-
mat. 

 
·  SSN. Social security number. 
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·  Form 1.P Categor ies. A drop-down list of the expense categories applicable 

to Form 1.P. 
 

·  Phone Number. 
 

·  Gender. Leave blank if the party is a corporation or other gender-neutral or-
ganization. 

Adding Records – Deleting Empty Records. It©s easy to add new records. You can 
press the Add At End button near the top of the screen or you can also click on the 
+ button on the Navigator bar. The first way adds a blank record at the end of the 
table, the second “ insert’ s”  a record before the current record. In most cases it won’ t 
make any difference whether you add or insert because when you press the Save To 
Table button, the record will jump into alphabetical order depending on the active 
column/field anyway. 
 
Sor ting Records. Like most Windows programs that present information in rows 
and columns, you can alphabetize the table by clicking on most of the column head-
ings. A caret (^) mark will appear next to the column header to denote the column/
field on which the table is being sorted. 
 
Moving Records in the Table. If you don’ t want to sort your entries (records), but 
still want to force them into a particular order, you can click on the gray left margin 
and drag a record to a new location in the table. When you begin dragging, you’ ll 
see a thick black line appear between records. That shows you the new location of 
the record you’ re dragging when you release the mouse button. 
 
Save to Table. Although you do your data entry on the top half of the screen, noth-
ing you enter becomes permanent (that is, part of the database), until you click on 
the Save to Table button. You can also use <CTRL><T> instead of clicking on the 
button. You’ ll not that if you attempt to leave an entry/record without saving it to the 
table, a notification dialog will be displayed. Clicking Yes in that dialog will per-
form the “save.”  
 

First Completed Record in Next of Kin Worksheet of Sample File 
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That’s it for general information, what follows is specific to the Sample file. 
 
The surviving family members of the Sample probate file are the spouse and two 
children. Click the Display menu and choose Worksheets, then Next of Kin. 
You’ ll see a screen similar to the one shown on the previous page. Alternately, click 
on the Next of Kin Worksheet button on the tool bar at the top of the screen. 
 
·  When the Next of Kin Worksheet appears the cursor will be positioned in the 

Name field. Type: “Mary Lou Grenessem.”  Each kin, legatee, devisee or other 
interested party will be on a single line of the table. It’s best to work from left to 
right, top to bottom. 

 
After entering the name, Press <TAB> to move to the next field—Street Address. 
Here is the information for the next few text input box fields: 
 
 Street Address 1702 Lakeside Drive 
 City, State & Zip Columbus, Ohio  43215 
 Relationship Daughter 
 Birth Date Skip for adults 
 Social Security No. 123-45-6789 
 1.P Categories. Leave blank 
 Phone No. 614-555-1212 
 
 The thus far completed worksheet is shown on the preceding page. 
 
·  The next set of fields is comprised of checkboxes that can be checked to send a 

person’s name and/or address information to any of the listed forms. Put a 
checkmark in the Form 1.0(F) box. This will cause the kin you are about to en-
ter to be sent to the front side of Form 1.0.  
 
TIP: If you’d like to see a reminder of the complete form name for any form 
number, you can click your mouse on the form number or name and you’ ll see 
the complete name in the pop-up hint window as well as on the status bar at the 
bottom of the screen. If you select that submenu you’ ll see a list of each form 
number’s complete name. 

During the remainder of the probate, the above-mentioned daughter will also be 
listed on reverse side of Form 1.0 Next of Kin because she is a legatee/devisee in her 
father’s will. In our Sample file, she’ ll also be notified of the probate of the will and 
maybe a half-dozen other consents and waivers throughout the course of the probate. 
Here©s the neat part. Once entered as a next of kin, Frank10 lets you send her name 
and, if applicable address, to any of the forms. All you need to do is check the ap-
propriate box. To send Mary Lou to the back side of Form 1.0, check the 1.0(B) 
checkbox. Mary Lou’s signature will also be required on the Notice of Probate 
(Form 2.0). You can check these boxes right now. 
 
To add a second child to the Next of Kin Worksheet, press the Add At End button. 
A new, blank next of kin record is placed at the end of the table and is ready to be 
completed like the first. The next child is entered as appears on the next page: 
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 Name Judy Grenessem 
 Street Address 2039 Loveland Drive 
 City, State & ZIP Columbus, Oh 43215 
 Relationship Daughter 
 Birth Date leave blank 
 Social Security Number 111-33-5555 
 1.P Categories. Leave blank 
 Phone No. 614-555-1212 
 
You’ ll notice that we put the surviving spouse on the Next of Kin worksheet. Al-
though the surviving spouse shows up automatically on all the forms as required, 
one unique occurrence is on the back side of Form 1.0 (where a spouse may or may 
not be included depending on the provisions of the will). In order to accommodate 
these types of situations, we usually add the surviving spouse to the Next of Kin ta-
ble so that we can direct the spouse’s name to any such forms as needed. 
 

Step 4. Completing the Asset/Receipt Worksheet 
 
With a moniker like Income/Asset/Receipts Worksheet, you can see why we 
simply refer to it as the Asset Worksheet. Remember, however, like the long name 
says, the Asset Worksheet is used for income and other receipts as well. Note at 
the outset that, as in the case of the Kin Worksheet, we use the term record to refer 
to a row in the table, and the word field to refer to a column in the table. 
 
The Top Half &  The Bottom Half. Like the Kin Worksheet, the Asset Work-
sheet is also divided into two halves. The top half is where you do all your data en-
try; the bottom half is used to view and navigate through all your records. Although 
you can enter information in any order on the top part of the screen, we recommend 
working from left to right. Follow the tabbing order. When you first view the work-
sheet, it©s empty except for one blank record – that is, there’s one blank row in the 
bottom half and the empty contents of that row are displayed on the top half. If you 
work from left to right on this first record, you©ll proceed through the various fields 
described below. Note that when you click on any input control on the top part of the 
screen you’ ll see a helpful hint regarding that component on the status line at the 
bottom of the screen. Sometimes it’s a complete form name where the control, for 
space limitations, only shows the form number. 
 

·  Descr iption. The Description box is like a mini word processor. It has word 
wrap and you can type hard carriage returns to force line breaks. Otherwise, 
your lines of text will be wrapped automatically according the width of the 
field on the destination form. There is no limit to the amount of text you can 
enter in the Description box although certain forms have limitations of 
which you must be aware. If a form©s textual limit is exceeded, you will be 
given a warning telling you to reduce the amount of text you are sending to a 
particular form. Form 5.6 is a case in point. If you look at the printed form, 
you’ ll see that the Supreme Court’s design does not leave much room for 
lengthy descriptions or carriage returns. 
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Two things to note about the Description box is that because it uses an RTF 
format for storing data, you cannot use certain characters. The curly or 
French braces are an example of illegal characters: {  and } . There are other 
illegal characters. Here are some examples: /, \, and <TAB>. Even though 
we’re mentioning these forbidden characters, you shouldn’ t need to worry 
much about them because if you happen to use them in a description, 
Frank10 will automatically remove it and substitute a similar character. Just 
so you know. 
 
The second thing to note is that your entries may look nicer in the context of 
inventories and accounts, if you conclude your descriptions with two carriage 
returns. For you youngsters, that means hitting the <ENTER> key. The first 
carriage return represents the end of the description and the second carriage 
returns ends up being a nice blank line that separates this description from 
any that follow it when it is transferred to a probate form. Here’s an example: 
 
Ok Way 
National City Bank Savings Account, Account No. 34-1628392-0034 
 
Better  Way 
National City Bank Savings Account, Account No. 34-1628392-
0034<ENTER> 
<ENTER> 
 
Note that although the description line may word wrap differently depending 
on your screen, the hard carriage returns will always mark the end of a line, 
regardless of whether it’s blank or has text on it. 

 
·  Miscellaneous. The next group of fields is for miscellaneous information. 

Note that the forms that require this field are listed in parenthesis to the left 
of the input control’s label. For example, the Amount/Value field should be 
completed for all forms you check. However, you only need to complete the 
Voucher field if you have checked that property for Form 13.0/13.1. Note 
also that the Distributee field contains a browse/edit button that opens a dia-
log containing a list of the names in the Next of Kin Worksheet. You can 
pick any name or names. Pick multiple names by clicking on the first name 
and <CTRL>clicking on any additional names. Of course, if you haven©t 
made any entries in the Next of Kin Worksheet, this dialog will be empty 
and you will not be able to make an entry in the Distributee field. The sub-
fields are listed below:  
 
Amount/Value (All) 
Appraised (5.1, 6.1) 
Voucher (13.1) 
Distributee (5.6, 5.9, 7.2, 10.0, 12.1, BMV3774 & Stock Power of Attorney) 
Public/Private (9.0) 
Fixed/Best (9.0) 
Cash/Terms (9.0) 
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Note that the Distributee dialog works like many Windows components that 
contain lists. If you wish to select one distributee, click on the name. If you 
wish to select more than one, noncontiguous distributee, click on the first one 
and <CTRL>-click on any others. If you wish to select more than one, con-
tiguous distributee, click on the first one and <SHIFT>-click on the last one. 
All the intervening names between the first and last will also be selected. 

 
·  Send To These Forms. This is the first set of fields available via the Cate-

gories group. Clicking on the Change button brings up a dialog box con-
taining a checkbox for each form to which “ this”  asset or item can be sent. 
Also, if you need to refresh your memory as to the name of any form num-
ber, just position the mouse cursor over the control and the complete form 
name will appear on the status line at the bottom of the screen. After you 
close the expandable list of fields, you©ll see that this field has a small 
amount of text that summarizes which boxes you have checked when the dia-
log is closed. 

 
·  Form Categor ies. Like the Send To These Forms group, this group of 

fields allows you to classify a particular piece of property. The classification 
is necessary with some forms so that Frank10 can put the value of the prop-
erty in the correct subtotal for that form. Not all forms require that you clas-
sify property. The list of forms is contained in the Categories dialog. You 
never need to memorize or look up categories. The appropriate list is associ-
ated with each form’s combo box. 
 
Form 4.0 – Application for Authority to Administer 
Form 5.1 – Assets & Liabilities to be Relieved from Administration 
Form 5.6A – Entry Relieving Estate from Administration 
Form 5.10 – Application for Summary Release from Administration 
Form 6.0/6.1 – Inventory & Appraisal 
Form 7.1 – Application for Family Allowance 
Form 7.2 – Application for Apportionment of Family Allowance 
Form 13.0/13.1 – Fiduciary’s Account 
Form 13.2 – Assets Remaining in Fiduciary’s Hands 
Computation of Executor/Administrator Fee 
 

·  Real Estate. This group of fields is for real estate. The information required 
can usually be obtained from the legal description or abstract of title. Most of 
the information in this column goes to the Surviving Spouse Affidavit, al-
though some is used for Form 12 – Certificate of Transfer. Like the last 
two groupings, display the subfields by clicking on the appropriate Change 
button. 

 
·  Vehicles. This group is similar to the others. It holds a subset of fields re-

lated to vehicles. Most of the information in this column goes to the BMV 
forms and is used for transferring motor vehicles to either the surviving 
spouse or some other transferee. You display the subfields by clicking on the 
Change button. 
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·  Stock. This group is also similar to the Real Estate column. It holds a sub-

set of fields related to stock. Most of the information in this column goes to 
the stock power of attorney and is used for transferring stock out of the name 
of the decedent. You display the subfields by clicking on the Change but-
ton. 
 

·  Personal Identifiers. Because Ohio law requires that the decedent’s confi-
dential information be protected from potential identity theft via public re-
cords, there is a group of fields in which you can enter “personal identifiers.”  
This information will not flow to the various probate forms with the excep-
tion of the Confidential Disclosure form. 

 
Adding Proper ty – Deleting Empty Records. It©s easy to add new records. You 
can press the Add At End button near the top of the screen or you can also click on 
the + button on the Navigator bar. The first way adds a blank record at the end of the 
table, the second “ insert’ s”  a record before the current record. In most cases it won’ t 
make any difference whether you add or insert because when you press the Save To 
Table button, the record will jump into alphabetical order depending on the active 
column/field anyway. 
 
Sor ting Records. Like most Windows programs that present information in rows 
and columns, you can alphabetize the table by clicking on some of the column head-
ings. A caret (^) mark will appear next to the column header to denote the column/
field on which the table is being sorted. 
 
Moving Records in the Table. If you don’ t want to sort your entries (records), but 
still want to force them into a particular order, you can click on the gray left margin 
and drag a record to a new location in the table. When you begin dragging, you’ ll 
see a thick black line appear between records. That shows you the new location of 
the record you’ re dragging when you release the mouse button. 
 
Save to Table. Although you do your data entry on the top half of the screen, noth-
ing you enter becomes permanent (that is, part of the database), until you click on 
the Save to Table button. You can also use <CTRL><T> instead of clicking on the 
button. You’ ll not that if you attempt to leave an entry/record without saving it to the 
table, a notification dialog will be displayed. Clicking Yes in that dialog will per-
form the “save.”  
 
That’s it for general information related to the Asset Worksheet, what follows is 
specific to the Sample file. 
 
The Sample probate file has household goods, a few bank accounts, some stocks 
and a couple parcels of real estate. To enter the assets, go to the Display menu, open 
the Worksheets submenu and select Asset Worksheet. You can also click on the 
Display Asset Worksheet button which is quicker. In the illustration above, it’s 
the 5th button from the left on the button bar near the top of the screen. When the 
worksheet appears on your screen it is blank and ready to accept your first asset en-
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try. The Asset Worksheet is not much different from the Next of Kin Worksheet 
that you already completed. Again, you’ ll work from left to right. 
 
·  When the Asset Worksheet appears, the cursor should be blinking in the De-

scription box. Type this property description: National City Bank, Savings 
Account No. 34-1628392-004. Press <TAB> to move to the next field to the 
right—Value.…  

 
·  This next section (of which Value is the first field) is actually a grouping of 

seven fields. Not every field in the Miscellaneous section needs to be com-
pleted. You’ ll probably always want to complete the Value field, you can enter 
the balance on date of death: $ 2,334.00. Note that you cannot enter dollar signs 
($) or commas (,) in numeric or dollar entries. Frank10 handles the formatting 
of numeric entries automatically. Here’s an explanation of the remaining Miscel-
laneous fields and their associated forms: 
 
Field—Forms which contain that field 
Appraised—Form 5.1 (realty only); Form 6.1 
Voucher—Form 13.1 
Distributee—Form 7.2; Form 10.0; Form 12.0/.1 
Public/Private—Form 9.0 
Fixed/Best—Form 9.0 
Cash/Terms—Form 9.0 

 
·  The next section is actually a collection of dialog boxes that are accessed by us-

ing the appropriate Change button. The first Change button is one you will 
almost always be using. It is a group of checkboxes that represent all of the pro-
bate and estate tax forms to which a piece of property may be sent. Put a check-
mark in the check boxes for Form 4.0, Form 6.0 and Form 13.0. This will 
cause the property you are about to enter to be sent to the Application for Au-
thority to Administer, the inventory, and the accounting forms. If you need a re-
minder of the complete form name for any form number, you can click your 
mouse on the form number and you’ ll see the complete form name in the pop-up 
hint window as well as on the status bar at the bottom of the screen. If you select 
that submenu you’ ll see a list of each form number’s complete name. In addition, 
if you click any form name it will automatically check that form’s checkbox. 

 
The remaining fields are grouped together as follows. Each subgroup is accessed by 
using the associated Change button. 
 
·  Send To. There are almost 40 destinations to which a record can be sent. They 

are all listed in the Send To dialog that displays when you click on the Send 
To’s Change button. Note that the last set of checkboxes relates to the Ohio Es-
tate Tax program—a separate and distinct program from Frank10. 

 
·  Category. In the case of some forms, for example Form 4.0, Frank10 needs to 

know the category of property so it can add it in correctly. Therefore, if you’ re 
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sending an item to Form 4.0 (i.e., you have the 4.0 checkbox checked), you’ ll 
need to click on the Categories Change button and select a category using the 
drop-down combo box for the particular form you’ re working on. In the case of 
Form 4.0, your choices are (1) Personal Property, (2) Annual Realty Rentals, 
or (3) Real Property. Each form in the Categories dialog box has a drop-down 
list of property classes or categories that you must select if you are sending an 
item to that form. The complete list of forms that have categories is: 
 
Form 4.0 Form 5.1 Form 5.6A 
Form 5.10 Form 6.0/6.1 Form 7.1 
Form 7.2 Form 13.0/13.1 Form 13.2 
Computation of Executor’s/Administrator/s Fee 
  

Continuing with the Sample example, the property you entered belongs on Form 
4.0 as "personal property"; 

 
·  on Form 6.0 as "Intangible Personal Property"; and 
 
·  on Form 13.0 as "Personal Property Not Sold". 

 
You can send the bank account to these three forms by checking the appropriate 
checkbox in the “Send This Property To …” dialog box. In the case of all three of 
these forms (4.0, 6.0 & 13.0) you will be required to select the appropriate property 
classification via the Category button. 
 
Because the real estate, stock and other Change buttons do not apply, you are done 
with this first record. You should click the Save to Table button and you’ ll see that 
the information on the top half of the screen has been placed in the first row of the 
table on the bottom half of the screen. Below is an illustration of what the Asset 
Worksheet will look like at this point in the date entry process. 

First Completed Record in Asset Worksheet of Sample File 
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To enter the next asset, click the Add At End button. Like the Next of Kin Work-
sheet, a new blank record is created at the end of the table for you to enter the nec-
essary information. By now, you should have the hang of moving from field to field 
and adding new records. Add the following asset: 
 
 Description City Bank 
  Savings Certificate #241435932 
 Value $1,040.00 
 Appraised Unchecked 
 Send To ... Forms 4.0, 6.0, & 13.0 
 
Also remember to select appropriate categories for these three forms as you did 
when you entered the first asset. In fact, the categories will be the same as the first 
asset. 
 
IMPORTANT NOTE. Don©t use dollar signs ($) or commas (,) when you enter 
amounts. Just numerals and decimal points will suffice. Leave the formatting to 
Frank10. 
 
Note that stocks, vehicles, real estate, and personal identifiers each have their own 
Change button for accessing additional related fields. 
 
Send this asset to the same three forms as the first asset, using the same asset catego-
ries. The rest of the asset worksheet can be completed by using the Add Property 
button and adding additional assets. You may enter assets in any order. If you wish 
to change their position on the worksheet you simply change the record number. 
When you leave that entry, by pressing the  <PAGE UP> or  <PAGE DOWN> keys 
on your keyboard, the asset will jump into position based on the record number. 
 
SMART TIP. If you’d like to put your property items in a particular order, click on 
the column title or header. A caret mark (^) will appear behind the title denoting 
which column is being sorted. Records in the table will be sorted according to the 
field on which you clicked. Finally, you should also take note of how we©ve used 
carr iage returns to make a better  looking pr intout by inser ting clean-looking, 
blank lines between each record in your  pr intouts. 
 

Step 5. Completing the Expense Worksheet 
 
Having learned how to make entries on the Next of Kin and Asset/Receipt work-
sheets, you won’ t find anything new on the Expense/Disbursement worksheet. 
You can find the Expense Worksheet on the Display menu, or you can use the 
Expense Worksheet speed button. All Pur itas Spr ings Software programs that 
have worksheets function the same way. So by now you have unknowingly learned 
all our programs. The Expense/Disbursement Worksheet is mainly different 
from the other worksheets in that expenses have an optional voucher number and a 
reduced set of form destinations. 
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·  When you start working on a record, the cursor should be blinking in the De-
scription box. Type this description: "Joann Sample, fiduciary fees." Remember 
what we said about the Asset Worksheet Description box because all that ap-
plies to the Expense Worksheet Description box. 

 
·  Press <TAB> to move to the next field. You are now in the Amount field. You 

can enter the fiduciary fees: $ 1,500.00. Note that you cannot enter dollar signs 
($) or commas (,) in numeric or dollar entries. Frank10 handles numeric format-
ting automatically. 

 
·  Press <TAB> to move to the Voucher field. This area lets you enter a voucher 

number if you have one. We used voucher number "1071." 
 
·  Press <TAB> twice to move the focus to the “Send To…” group. Put a check-

mark in the Form 13.0 box. This will cause the expense you are about to enter 
to be sent to the accounting forms. 
 

·  Press <TAB> enough times to move the focus to the “Form 13 Categories”  
drop down list box. Select Fiduciary Fees. You’ re done with the first record, 
click the Save To Table button (underneath the Description box) to post or 
save your first record. 
 

There are more expenses in the SAMPLE file, but we don©t think it©s necessary to go 
through each one. You©ve probably got the hang of it by now.  
 
SMARTTIP. At this point in the tutorial, you may have two or three pages stacked 
on your screen. You can use the Window menu to check. It©s good housekeeping 
practice to limit the number of pages displayed on your desktop to two or three. Use 
the Close Active Window button to put a page away when finished working with it. 
Don’ t worry if you have not saved your work, closing a window does not lose any 
information. You can redisplay a form just to make sure. Follow this practice of 
closing windows (forms) when you are done using them to conserve memory. 
 

Step 6. The Time &  Services Worksheet 
 
The Time & Services Worksheet functions in every way like the other work-
sheets. You can use it to enter a date, description, amount of time, and hourly rate 
for all your work on a file. When you need it, you can print the Time & Service 
Worksheet and use it as an exhibit in your own custom motions or applications. 
You can also use the Application for Allowance of Attorney Fees that is included 
in Frank10 on the Display menu’s Miscellaneous Other Forms submenu. Re-
quirements for the fee application typically vary from one jurisdiction to the next, so 
check first to make sure the Application is acceptable in your jurisdiction. 
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Step 7. Display and Complete the Remaining Forms 
 
As you display the forms you wish to file with the probate court, you will see that, 
for the most part, they are already complete. For this tutorial we will select one of 
the forms that needs a bit of information added—Form 1.0 Surviving Spouse, Next 
of Kin, etc. 
 
·  From the Display menu, choose Form 1.0. Notice that if you cannot remember 

the name of the form by its number, the status line at the bottom of the screen 
gives you the complete name of the form. 

 
·  The caption is already complete, and the next of kin are already on the form. The 

focus is toward the middle of the screen at the checkboxes near the bottom of the 
printed form. Place an ©x© in the checkbox, by clicking or by pressing the 
<SPACE BAR>. This indicates that the spouse is the natural parent of one or 
more of the decedent©s children.  

 
Of course, you©ll need more than Form 1.0. In fact, you©ll probably want to generate 
all or most of the following list of forms. The SAMPLE probate uses all of these. 
 

Form 1.0(B) - List of legatees/devisees 
Form 2.0 - Application to Probate Will 
Form 3.0 - Appointment of Appraiser 
Form 4.0 - Application for Authority to Administer 
Form 6.0/6.1 - Inventory & Appraisal 
Form 12.0/12.1 - Certificate of Transfer 
Form 13.0/13.1 - Final Accounting 

 
Now, or at some time in the future, you©ll be visiting each of the above forms using 
the Display menu or the Main Window. When they appear on the screen, you 
should use <TAB> to move from field to field and complete any necessary informa-
tion. Remember, always press <TAB> after  each entry. Some forms will have a 
lot to complete, other forms will be completed in their entirety and you©ll enter noth-
ing. It depends on the form and the information it requires. 
 
SPECIAL NOTE: You cannot print Form PI (the Personal Identifier form) if you 
are printing any other form along with it. Form PI can only be printed by itself due 
to the landscape orientation of the form. If you click any other checkbox, the Form 
PI checkbox will automatically clear. Also note that the four database worksheets 
can only be printed from the Print submenu. 
 

Step 8. Save Changes 
 
You won’ t see anything happen when you click on this command in the Main Win-
dow, but your file is being resaved using the file name you gave it in Step 2. Always 
remember the mantra that experienced computer users implement for saving — 
early and often. 
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Step 9. Pr inting the Forms 
 
This step is the easiest. Click the menu©s File|Print|Selected Forms item. You©ll 
see four pages of checkboxes which you can check to print. If you©re looking at a 
form that you just corrected and simply wish to print the form you©re looking at on 
the screen, use the Print This Form button on the tool bar at the top of the screen. If 
you want to print only the front or back of a form, use the Send to Word Proces-
sor function. You can always find a complete description of the form©s number and 
name on the status line at the bottom of the Frank10 window when you hold your 
mouse cursor over the form number. 
 
To see the check boxes for Forms 9 through 13, click on the tab at the top of the dia-
log box. 
 

Step 10. Sending Forms to your Word Processor  
 
Aside from Frank10’s ability to print forms on your printer, a powerful and useful 
feature is its ability to send entire sets of forms to your word processor. In this in-
stance, Frank10 doesn’ t really print your forms, instead it creates an RTF file that 
your word processor can read so that when you “print”  your forms, your word proc-
essor is started and the automatically-generated RTF file is opened. The purpose of 
this feature is to let the user make form and substance modifications to forms and 
data that would otherwise be impossible within the confines of the Frank10 pro-
gram itself. Microsoft developed the RTF standard so it comes as no surprise that 
Microsoft’s Word for Windows is best at reading and writing RTF files. Therefore, if 
you have MS Word, you should go to the Options menu and check that Word for 
Windows is selected as your word processor using the Set Word Processor item. 
If you use MS Word, you should be able to print your forms with little or no adjust-
ments. 

Print Selected Forms Dialog 
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WordPad. If you do not use Word for Windows as your word processor, your next 
choice of word processor may be WordPad. It is capable of reading and writing RTF 
files, however, its ability to read formatting information is somewhat lacking and 
therefore it will be necessary to set the Page Setup parameters so that the margins 
are: top=0.75” ; left=0.75” ; right=0.75” ; and bottom=0.25” . Setting the margins is 
very important because it governs both line breaks and page breaks. It is impor-
tant to remember that every computer renders True Type fonts differently, so if inap-
propriate line breaks are ruining the format of your form or schedule, try adjusting 
the margins. Usually margins that are too small are not a problem; however, 
margins that are too big cause long text lines to break across two lines instead 
of one. This destroys the look and format of the remainder  of the page. So if this 
happens near the top of a page, the whole page is affected. While Word for Windows 
gets the margin settings from the RTF file header, WordPad is unable to do so. Con-
sequently, if you’ re using WordPad you’ ll want to set the Page Setup parameters 
that are available on WordPad’s File menu. Note that the version of WordPad that 
comes with Windows 95 does not render  line spacing and under lined tabs accu-
rately enough to generate acceptable IRS forms. Therefore, if you have Win-
dows 95 and don’ t use Microsoft’s Word as your  word processor , you may want 
to obtain an alternate application for  displaying RTF files.  
 
WordPerfect. WordPerfect also reads and writes RTF files but its ability to do so is 
severely hampered by the fact that it miscalculates line spacing. Even if you make 
template corrections in WordPerfect, WordPerfect doesn’ t seem to be able to recog-
nize its own RTF files thus rendering the otherwise excellent Reveal Codes feature 
useless. We recommend not using WordPerfect; use WordPad instead. 
 
Modifying Templates 
 
Sometimes a jurisdiction might have special requirements related to the forms. A 
county, for example, may require that the attorney’s name and telephone number 
appear in the upper left corner of every form. 
 
That’s where the Modify Templates command on the Options menu is useful. This 
command lets you load the Frank10 form RTF template into your word processor so 
you can make minor adjustments such as adjusting margins or tabs. Be very careful 
when modifying the templates and be ready to reinstall Frank10 if you can’ t restore 
a template to an acceptable, error-free format. Here are a few tips. 
 
1. Avoid modifying the first or last lines of any template. 

2. Make small adjustments and then test them instead of making many or major 
modifications. Only work on one template page at a time. 

3. Do not change or delete variables, that is the numeric codes enclosed with 
slashes (i.e. /&25/). 

4. Resaving a file using WordPad reduces a file’s size by more than 50%. It’s a 
good idea to do this with any RTF files you modify, however, after you resave 
the file using WordPad, it will be necessary to paste the margin information into 
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the RTF file using NotePad because WordPad unfortunately strips margin infor-
mation. The margin information line that needs to be pasted is as follows: 
 
Here are the steps we ourselves use when creating and modifying the RTF tem-
plates. 

5. Make your modifications in Word for Windows. If you don’ t have Word, any 
word processor that can open and save RTF files will do. WordPad and Word-
Perfect can both handle RTF files, but use Word for the best results. Be careful 
that you don’ t accidentally convert the file to some other type; make sure you 
save the file as an RTF file. 

6. Open the RTF file in WordPad and resave it. Word processors like Word have a 
tendency to add huge “headers”  or formatting code to the beginning of the file. 
Resaving the file using WordPad will strip the header to a bare minimum. 

7. Unfortunately, WordPad trims the header a little too much. As a result, the RTF 
file loses its margin information and the margin information can be reinserted by 
opening the RTF template in NotePad and manually replacing the header with 
the header excerpt we include in the RTF folder under the name Header.rtf. Be 
careful with this last step. Open up any other RTF template in NotePad if you’d 
like to see a sample of how the header should be prepended. 
 
Note that the header.rtf file is a simple ASCII text file and is not an RTF file (in 
spite of the fact that it has an RTF extension). As such, it cannot be loaded into 
WordPad or your word processor as an RTF file. Open the header.rtf file using 
NotePad. 

 
As tedious as these steps may seem in writing, they are actually quite easy to per-
form and once you’ve completed them once or twice, the resaving/prepending proc-
ess described in steps 2 and 3 can easily be performed in seconds. In this context be 
aware of two points: (1) our forms comply with the Supreme Courts typographical 
specifications “as is”  and shouldn’ t need modification; (2) any changes you make 
are on a one-time basis and therefore once you’ve tweaked the form as desired, 
you’ re good to go—forever. 
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This paper manual is merely an outline of the basics of installation, getting started 
and information entry. You can get additional help via the program’s Help|Table of 
Contents menu. This program has context-sensitive help. That means that you get 
help on a specific menu item without searching for that topic. Simply highlight the 
menu command and press <F1>. Many other objects on your screen have associated 
help topics, i.e., window scaling. When in doubt, move focus to the component object 
and press <F1> . 
 
If you’ re like us, you might be doubtful as to whether help files can be truly helpful. 
Regardless of  any drawbacks, we found them to have significant benefits over their 
paper counterpart. 
 

Help Is Always There 
When we were at the office, the manual was at home. When we were on the computer 
at home, the manual was at the office. On unfortunate occasions, that alone can make 
you lose a day. It never happens with help files. They’ re always there. A copy for 
your home computer, and a separate one for the office. Ditto for your laptop! When 
you’ re desperate for information, you can always count on its accessibility. 
 

Help Is Hyper linked, Searchable &  Better Indexed����
We took extra time to develop a logical system of indexing. You should find that a 
help file’s searchability can be a time-saver when you’ re looking for a snatch of text. 
The point and click links between key words provide instant information without 
fumbling through page after page looking for something. This non-linear  characteris-
tic is part of what makes help files so uniquely useful. 
 

Help Is Up To Date����
Because they are printed in large quantities, paper manuals fall out of synch with last-
minute or late-minor programming changes. Help files, on the other hand, are easier 
to keep current with programming changes because their modification involves no 
additional processing steps to implement (i.e., physical transportation, printing, bind-
ing, etc.). 
 

Paper Fix����
Don’ t forget that any help topic can be printed simply by pressing the help window’s 
Print button, or using the menu’s Print Topic command. 
 
 



%�%�%�%� 





&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 
&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 
&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 
&�� � "  �� 
� � � � 	 � 
� � � ' � 	� 
&� �( � 






Checking out the following help topics before dig-
ging into Frank10 will help reduce the learning 
curve, although you should find Frank10 relatively 
straightforward to use. 
 
1. What is the DEFAULT.F10 file? 
This topic explains how to customize the blank, start-up probate form set so that 
common, unchanging information, i.e., county name, etc., is set up to appear auto-
matically when you select New from the File menu.  
 
2. Using The Keyboard 
This is a good topic to print because it summarizes all the key commands which 
are available in the program. 
 
3. Overr iding Answers 
You’ ll use this command when you need to manipulate entries in text input dialogs 
that have a light-blue colored background. 
 
4. Common Questions 
If we get recurring questions about a particular facet of Frank10 operation, you 
will find the relevant help topic cited here. 
 
5. Probate Tracker  
This extremely handy time table can be printed out and stapled on your file cover. 
It lets you chart the due date for the various probate forms. 
 
6. The Estate Tax Connection 
This topic explains how to transfer your probate information to the Ohio Estate 
Tax program. 
 
7. Tr icks For  Better  Looking Pr intouts 
Tips for getting the most out of Frank10 and its ability to generate printed forms, 
for example, the inventory and final accounting. 


